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Satura râdîtâjs
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Vispârçjâ apkope

Brîdinâjums

�

�

�

�

�

�

�

�

Lai izvairîtos no bojâjumiem vai nepareizas
darbîbas:

Rûpçjieties par to, lai nepakïautu
atskaòotâju pârmçrîgam karstumam –
sildîðanas iekârtu vai tieðu saules staru
ietekmei.

Rûpçjieties par to, lai atskaòotâjs
nenokristu un lai uz tâ neuzkristu citi
priekðmeti.

Rûpçjieties par to, lai atskaòotâjs nenokïû-
tu ûdenî, lai ûdens nepiekïûtu austiòâm vai
neiekïûtu bateriju nodalîjumâ. Pretçjâ gadî-
jumâ tas var radît nopietnus bojâjumus.

Rûpçjieties par to, lai atskaòotâjs atrodas
droðâ attâlumâ no aktîviem mobilajiem
tâlruòiem. Pretçjâ gadîjumâ tas var radît
atskaòotâja darbîbas traucçjumus.

Dublçjiet savus failus. Pârliecinieties, ka
esat saglabâjuði oriìinâlos atskaòotâjâ
ielâdçtos failus. “Philips” neuzòemas
atbildîbu par nozaudçtajiem datiem, ja
atskaòotâjs ir bojâts vai informâcija nav
nolasâma.

Lai izvairîtos no bojâjumiem un atskaòotâja
darbîbas traucçjumiem, organizçjiet
(pârraidiet, dzçsiet utt.) mûzikas failus tikai
ar komplektâ iekïauto mûzikas
programmu.

Tîrot atskaòotâju, nelietojiet tâdus tîrîðanas
lîdzekïus, kas satur spirtu, amonjaku,
benzînu vai abrazîvas vielas. Pretçjâ
gadîjumâ tas var sabojât ierîci.

Darbîbas un glabâðanas temperatûra

Detaïu/piederumu maiòa

Dzirdes aizsardzîba

Ðai lietoðanas instrukcijai ir informatîvs raksturs.

Ja informâcija latvieðu valodas lietoðanas instrukcijâ
atðíiras no informâcijas angïu valodas lietoðanas
instrukcijâ, noteicoðâ ir lietoðanas instrukcija angïu
valodâ.

Pieïaujamâ atskaòotâja lietoðanas temperatûra
ir no 0 lîdz 35 °C.

Pieïaujamâ atskaòotâja glabâðanas temperatûra
no -20 lîdz 45 °C.

Bateriju darbîbas laiks var samazinâties, lietojot
atskaòotâju zemu temperatûru ietekmç.

Apmeklçjiet www.philips.com/support mâjaslapu,
lai pasûtîtu detaïas/piederumus to nomaiòai.

Klausoties pârâk skaïi atskaòotâju, var tikt bojâta
jûsu dzirde. Atskaòotâja skaòas diapazons var
sasniegt tik augstu decibelu lîmeni, ka, klausoties
atskaòotâju ðâdâ skaïumâ ne ilgâk par minûti, tas
var radît dzirdes bojâjumus pat veselâm personâm.
Augstâkie decibeli paredzçti personâm ar dzirdes
traucçjumiem.

Esiet uzmanîgi – dzirde pierod pie skaòas skaïuma!
Ilgi klausoties skaïi atskaòotâju, jûs pierodat pie
attiecîgâ skaïuma un jums tas var ðíist normâls,
taèu patiesîbâ ðâda skaïa atskaòotâja klausîðanâs
var bojât jûsu dzirdi. Lai no tâ izvairîtos, attiecîgi
pirms jûsu dzirde ir pieradusi pie skaòas skaïuma,
noregulçjiet to dzirdei droðâ lîmenî un negrieziet
skaïâk.

Noregulçjiet skaïumu klusâkajâ reþîmâ.

Lçnâm grieziet skaïâk, kamçr saklausât skaòu
skaidri un tas nerada diskomfortu jûsu dzirdei.

Ilgstoða atskaòotâja klausîðanâs pat dzirdei droðâ
skaïumâ var ietekmçt jûsu dzirdi un bojât to.

Kausieties atskaòotâju saprâtîgu laiku un ievçrojiet
atbilstoðus pârtraukumus.

Klausieties atskaòotâju dzirdei droðâ skaïumâ un
saprâtîgu laiku.

Esiet uzmanîgi, regulçjot skaïumu – dzirde pierod
pie skaòas skaïuma.

Negrieziet skaïumu tâ, ka nedzirdat apkârt
notiekoðo.

Neklausieties atskaòotâju situâcijâs, kas var kïût
bîstamas.

�

�

�

Ilgstoða atskaòotâja klausîðanâs maksimâlâ
skaïumâ var radît dzirdes traucçjumus.

Klausieties atskaòotâju mçrenâ skaïumâ

Lai nodroðinâtu dzirdei droðu skaïuma lîmeni

Klausieties atskaòotâju saprâtîgu laiku

Klausoties atskaòotâju, ievçrojiet ðâdas
prasîbas

1. Svarîga droðîbas informâcija



Neklausieties atskaòotâju, vadot automaðînu,
braucot ar divriteni, vizinoties ar skrituïslidâm utt.
Tas var izraisît ceïu satiksmes negadîjumu un ir
aizliegts daudzâs valstîs.

Ierîces neatïauta modificçðana liedz tâs lietoðanas
tiesîbas.

Visu citu zîmolu un ierîèu nosaukumi ir attiecîgo
firmu un organizâciju preèu zîmes.

Jebkuru ierakstu neatïauta kopçðana no interneta
vai audiodiskiem ir autortiesîbu un starptautisko
lîgumu pârkâpums.

Ar autortiesîbâm aizsargâta materiâla, tai skaitâ
datorprogrammu, failu, pârraiþu un skaòas ierakstu,
neatïautu kopiju veidoðana var bût autortiesîbu
pârkâpums un par to var saukt pie
kriminâlatbildîbas. Ierîci nedrîkst izmantot ðâdiem
mçríiem.

“Windows Media” un “Windows” logo ir “Microsoft
Corporation” ASV un/vai citâs valstîs reìistrçtas
preèu zîmes.

“Philips” ciena citu intelektuâlo îpaðumu un lûdz to
darît arî jums.

Internetâ atrodamais multimediju piedâvâjums var
bût radîts un/vai izplatîts bez tâ sâkotnçjâ
autortiesîbu turçtâja piekriðanas.

Kopçjot vai izplatot neautorizçta satura informâciju,
var tikt pârkâpti autortiesîbas regulçjoði normatîvie
akti daþâdâs valstîs, ieskaitot jûsçjo.

Ievçrot autortiesîbas regulçjoðos normatîvos aktus
ir jûsu atbildîba.

Audioierakstu veidoðana un pârsûtîðana no jûsu
datora uz pârnçsâjamo atskaòotâju atïauta tikai
publiskajos domçnos vai tad, ja audioierakstu
autortiesîbas ir aizsargâtas. Ðâdus datus drîkst
izmantot tikai privâtiem, nekomerciâliem mçríiem
un ir jâievçro autortiesîbas regulçjoðo normatîvo
aktu prasîbas, kur var bût noteikts, ka kopiju
izgatavoðana ir aizliegta. Videoieraksti var bût
aizsargâti ar pretkopçðanas tehnoloìijâm, kas

neatïauj veidot kopijas. Ðâdâ gadîjumâ ieraksta
funkcija nedarbosies un jûs par to saòemsit
paziòojumu.

“Philips” ir apòçmies uzlabot ierîces kvalitâti un
paplaðinât lietotâja pieredzi. Ðo ierîci izmanto
informâcijas/datu ierakstîðanai energoneatkarîgajâ
atmiòâ. Dati tiek izmantoti to kïûdu vai problçmu
identifikâcijai, ar kurâm lietotâjs saskâries,
izmantojot ierîci. Piemçram, ierîce saglabâ datus par
atskaòoðanas laiku mûzikas reþîmâ, atskaòoðanas
laiku uztvçrçja reþîmâ un baterijas enerìijas lîmeni.
Saglabâtie dati neatklâj izmantoto informâcijas
saturu, mediju vai lejupielâdçðanas avotu. Dati tiek
izmantoti TIKAI tad, ja lietotâjs ierîci nogâdâ
“Philips” servisa centrâ, lai noteiktu un novçrstu
bojâjumus. Servisa centram ir jânodroðina piekïuve
datiem pçc lietotâja pirmâ pieprasîjuma.

Ja jûs pilnîbâ nepiekrîtat visiem iepriekð minçtajiem
nosacîjumiem, jums jâpârtrauc ðî avota koda
lietoðana un jâdzçð tas no jûsu atmiòas ierîces.

1. Monkey's Audio SDK un avota kods var tikt
brîvi izmantoti, lai pievienotu APE formâta
atskaòoðanu, kodçðanu vai tagu atbalstam
jebkuram produktam, bezmaksas vai
komerciâli. Koda lietoðanai patentçtâm
darbîbâm, kas neatbalsta oficiâlo APE
formâtu, nepiecieðama rakstiska autora
piekriðana.

2. Monkey's Audio avots var bût iekïauts GPL un
atvçrta -avota programmatûrâ, lai arî
Monkey's Audio pats par sevi netiks uzskaitîts
ârçjâ licencçðanas prasîbâ vai citos vîrusu
avotu ierobeþojumos.

3. Kodu izmaiòâm vai uzlabojumiem ir jâsekmç
Monkey's Audio projekts bez ierobeþojumiem
vai autoru honorâriem, ja vien par to nav
vienojuðies rakstiski ar autoru.

4. Jebkuri lietotie avotu kodi, idejas, vai izlases
ir nepârprotami jâdara zinâmi kodu
lietojoðajâ programmatûrâ.

5. Lai arî programmatûra ir pamatîgi
pârbaudîta, autors nekâdâ veidâ nav atbildîgs
par zaudçjumiem tehnisku defektu vai
nepareizas lietoðanas dçï.

Modifikâcijas

Informâcija par autortiesîbâm

Esiet atbildîgi! Ievçrojiet autortiesîbas!

Dati

Monkey's Audio dekoders
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Esiet atbildîgi
Ievçrojiet autortiesîbas



FLAC dekoders XPAT XML sintaktiskais analizators

Autortiesîbas © 2000, 2001, 2002, 2003, 2004,
2005, 2006, 2007, 2008, 2009 Dþoðs Koalsons
(Josh Coalson).

Pârdale un izmantoðana avota un binârajâ veidâ ar
vai bez izmaiòâm ir pieïaujama, ja tiek ievçroti ðâdi
nosacîjumi:

Avota koda pârdalei jâbût saskaòâ ar iepriekð
aprakstîto autortiesîbu paziòojumu, tâlâk
aprakstîtajiem nosacîjumiem un ðo atrunu.

Visâ dokumentâcijâ un/ vai jebkuros citos
materiâlos, kas tiek nodroðinâti kopâ ar binâro
pârdali, ir jâatveido iepriekð aprakstîtais
autortiesîbu paziòojums, tâlâk aprakstîtie
nosacîjumi un ðî atruna.

Ne “Xiph. OrgFoundation”, ne tâ ziedotâju
nosaukumus drîkst izmantot, lai apstiprinâtu
vai reklamçtu produktus, kas iegûti no ðîs
programmatûras, ja vien tiek saòemtas
rakstiskas tâ atïaujas.

Ðo programmatûruautortiesîbu îpaðnieki un
atbalstîtâji nodroðina tâdu, kâda tâ ir, un jebkuras
tieðas vai netieðas garantijas, ieskaitot, bet ne tikai,
nozîmçtâs tirdzniecîbas garantijasun piemçrotîbu
konkrçtammçríim,tiek noraidîtas. Nodibinâjums vai
tâ ziedotâji nekâdâ gadîjumâ nav atbildîgi par
jebkâdiem tieðiem, netieðiem, nejauðiem, îpaðiem,
izòçmuma vai izrietoðiem zaudçjumiem (ieskaitot,
bet ne tikai, aizstâjamo preèuvai pakalpojumu
sagâdi, lietoðanas, datu vai peïòas zaudçjumiem, vai
komercdarbîbas traucçjumiem) neatkarîgi no to
raðanâs veida un vietas, neatkarîgi no lîguma, tieðâs
atbildîbas vai civiltiesîbu pârkâpumiem (ieskaitot
nolaidîbu vai citâdi), kas rodas
jebkâdasðîsprogrammatûras izmantoðanas dçï, pat
ja ir brîdinâts par ðâda kaitçjuma iespçju.

Autortiesîbasaizsargâtas (c) 1998., 1999.,
2000.“Thai Open Source Software Center Ltd.”.

Ar ðo atïaujubez maksastiek pieðíirtas tiesîbas
jebkurai personai, kas saòem ðîs programmatûras
un saistîto dokumentâcijas failu kopiju
(“Programmatûra”), izmantot programmatûru bez
ierobeþojumiem, tostarp bez ierobeþojumiem to
izmantot, kopçt, modificçt, apvienot, publicçt,
izplatît, sublicencçt un/ vai pârdot programmatûras
kopijas, un ïaut to arî personâm, kam
programmatûra tiek nodota, ievçrojot ðâdus
nosacîjumus:

Visâs programmatûras kopijâs un nozîmîgâs
programmatûras daïâs ir jâiekïauj iepriekð
aprakstîtais autortiesîbu paziòojums un ðis atïaujas
paziòojums.

�

�

�

ÐÎ PROGRAMMATÛRA TIEK NODROÐINÂTA TÂDA,
KÂDA TÂ IR, BEZ JEBKÂDÂM TIEÐÂM VAI
NETIEÐÂM GARANTIJÂM, IESKAITOT, BET NE
TIKAI, NOZÎMÇTAS TIRDZNIECÎBAS GARANTIJAS
UN PIEMÇROTÎBU KONKRÇTAM MÇRÍIM, UN
NEAIZSKARAMÎBU.

AUTORI VAI AUTORTIESÎBU ÎPAÐNIEKI NEKÂDÂ
GADÎJUMÂ NAV ATBILDÎGI PAR JEBKÂDÂM
PRETENZIJÂM, BOJÂJUMIEM VAI CITÂM
SAISTÎBÂM, VAI NU LÎGUMA DARBÎBÂ,
CIVILTIESÎBU PÂRKÂPUMÂ VAI KÂ CITÂDI, KAS
RADUÐIES SAISTÎTI VAI NESAISTÎTI AR
PROGRAMMATÛRU VAI TÂS LIETOÐANU, VAI
CITÂM DARBÎBÂM AR PROGRAMMATÛRU.
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Ierîces otrreizçjâ pârstrâde

Brîdinâjums

� Ierîcçm ar “nemainâmâm” iebûvçtajâm
baterijâm: Paðrocîgi mainot (vai mçìinot
nomainît) iebûvçto bateriju, tiek anulçta
garantija. Ðo darbîbu drîkst veikt tikai
beidzoties ierîces kalpoðanas laikam. Paziòojums Eiropas Savienîbai

Ierîce ir raþota, izmantojot augstas kvalitâtes
materiâlus un sastâvdaïas, ko var pârstrâdât un
izmantot atkârtoti.

Ja ierîce ir maríçta ar îpaðu simbolu – pârsvîtrotu
konteineru – tâ atbilst Eiropas Direktîvai
2002/96/EK.

Neizmetiet ierîci kopâ ar mâjsaimniecîbas
atkritumiem. Lûdzu, iepazîstieties ar savas valsts
tiesîbu aktiem, kas nosaka videi kaitîgo preèu –
elektrisko un elektronisko iekârtu –
apsaimniekoðanas prasîbas, kâ arî noskaidrojiet
ðâdu iekârtu savâkðanas punktu atraðanâs vietas.

Pareizi atbrîvojoties no vecajâm ierîcçm, tiks
saudzçta vide un cilvçku veselîba.

Ierîcç iebûvçta pârlâdçjamâ baterija, uz kuru attiecas
Eiropas Direktîva 2006/66/EK. Tâ nosaka, ka ierîci
nedrîkst izmest kopâ ar mâjsaimniecîbas
atkritumiem.

Lai nodroðinâtu kvalitatîvu ierîces darbîbu, kâ arî lai
saskaòâ ar ðo instrukciju nomainîtu iebûvçto
bateriju, nogâdâjiet ierîci speciâlistam oficiâlajos
servisa centros.

Lûdzu, iepazîstieties ar savas valsts tiesîbu aktiem,
kas nosaka videi kaitîgo preèu – bateriju un
akumulatoru – apsaimniekoðanas prasîbas, kâ arî
noskaidrojiet ðâdu ierîèu savâkðanas punktu
atraðanâs vietas. Pareizi atbrîvojoties no vecajâm
ierîcçm, tiks saudzçta vide un cilvçku veselîba.

Ðî ierîce atbilst Eiropas Savienîbas radiotraucçjumu
prasîbâm.

... Svarîga droðîbas informâcija
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Komplektâ iekïautie rîki

Piezîme

� Attçliem ir informatîvs raksturs. “Philips” ir
tiesîbas mainît krâsu/dizainu, nebrîdinot
par to.

Atskaòotâjâ ielâdçtâ programmatûra

Atskaòotâjâ ielâdçtie faili

Pârbaudiet, vai esat saòçmuði ðâdus rîkus:

Atskaòotâjs

Austiòas

USB vads

Âtrâ starta padomdevçjs

Droðîbas un garantijas talons

atskaòotâjâ ir saglabâta ðâda programmatûra:

programmatûra (atjaunina
atskaòotâja programmatûru un organizç jûsu
mediju bibliotçku datorâ un atskaòotâjâ).

programmatûra
(pârveido video failus tâdâ formâtâ, ko atbalsta
atskaòotâjs, un pârraida pârveidotos failus uz
atskaòotâju).

Lejupielâdçjiet datorâ programmu “Philips
Songbird” no mâjaslapas
www.philips.com/Songbird vai
www.philips.com/support

atskaòotâjâ ir saglabâti ðâdi faili:

Lietoðanas instrukcija;

Bieþâk uzdotie jautâjumi.

VIBE

“Philips Songbird”

“Philips Media Converter”

VIBE

�

�

�

�

�

�

Lai iegûtu programmas “Philips Songbird” un
“Philips Media Converter”:

2. Jûsu jaunais atskaòotâjs



Pârskats

Vadîbas

“Mâjas” izvçlne

Navigâcija pa “Mâjas” izvçlni

1.

2. Ekrâns

3.

4.

5.

6. RESET

7.

8.

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Piespiediet un paturiet nospiestu:
ieslçdz/izslçdz atskaòotâju

Nospiediet: izvçlas opcijas vai
sâk/pauzç/atsâk atskaòoðanu

Nospiediet: parâda opciju izvçlni

Piespiediet un paturiet nospiestu:
bloíç/atbloíç visus taustiòus

3.5 mm austiòu kontaktspraudnis

Nospiediet: pârlec uz iepriekðçjo/nâkamo
opciju. Piespiediet un paturiet nospiestu:
opciju sarakstâ, kas sakârtots alfabçta secî-
bâ, parâda paðreizçjâs opcijas sâkumburtu

Nospiediet: palielina/samazina skaïumu

Piespiediet un paturiet nospiestu: âtri
palielina/samazina skaïumu

Nospiediet: pârlec uz iepriekðçjo/nâkamo
opciju. Piespiediet un paturiet nospiestu: âtri
meklç uz priekðu vai atpakaï vienâ failâ

Piespiediet ar lodîðu pildspalvas galu, ja
ekrâns nereaìç, spaidot taustiòus

USB savienotâjs atskaòotâja uzlâdçðanai un
datu pârraidei

Nospiediet: atgrieþas vienu lîmeni atpakaï

Piespiediet un paturiet nospiestu: atgrieþas
“Mâjas” izvçlnç

Mûzika atskaòotu audiofailus

Video skatîtos video

Attçli skatîtos attçlus

FM radio uztvertu FM radio
ierakstîtu no FM radio
(pieejams tikai daþiem
modeïiem)

Mapes pârskats parâdîtu failus mapçs

Iestatîjumi pielâgotu VIBE atska-
òotâja iestatîjumus

Paðreiz parâdîtu paðreiz notie-
koðâs atskaòoðanas
sarakstu

opciju sarakstâ:

atskaòoðanas sarakstâ:

atskaòoðanas sarakstâ:

Izvçlne Reþîms Lai

atskaòotais

... Jûsu jaunais atskaòotâjs
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�

�

�

�

�

�

�

�

�

�

No “Mâjas” izvçlnes jûs varat piekïût
funkcionâlajâm izvçlnçm, nospieþot navigâcijas
taustiòus un .

Lai atgrieztos iepriekðçjâs izvçlnçs, piespiediet
. Lai atgrieztos “Mâjas” izvçlnç, piespiediet

un paturiet nospiestu .

Mûzikas atskaòoðanas vai radio atskaòoðanas laikâ:

Piespiediet taustiòu .

Pçc izvçles, piespiediet un izvçlieties
(Paðreiz atskaòo) vai

(Pçdçjais atskaòotais).

Piespiediet un paturiet nospiestu taustiòu
.

“Mâjas” izvçlnç piespiediet taustiòu un
izvçlieties (Tçma).

Lai atskaòoðanas laikâ netîðâm nenospiestu
taustiòus, varat izmantot opciju tos bloíçt.

Piespiediet un paturiet nospiestu taustiòu
, lai bloíçtu vai atbloíçtu taustiòus.

Visi taustiòi, izòemot skaïuma taustiòus, ir
bloíçti, un ekrânâ redzama bloíçðanas
ikona.

Lai taupîtu enerìiju, ekrâns pçc noteikta laika
automâtiski izslçdzas, ja:

atskaòotâjs ir dîkstâvç;

sadaïâ (Ekrâna
iestatîjumi) (Fona
apgaismojuma taimeris) ir izvçlçts attiecîgais
iestatîjums.

Piespiediet jebkuru taustiòu.

Austiòu lietoðanas laikâ “SafeSound” nodroðina
mûzikas klausîðanos droðâ veidâ.

Kad jûs klausâties mûziku caur austiòâm, skaòas
spiediens uz jûsu ausîm tiek novçrtçts1 pçc
atskaòotâja un austiòu elektroniskiem parametriem.
Tas tiek novçrtçts un salîdzinâts ar skaòas spiediena
atsauces lîmeni2. Tâ rezultâtâ daþâdu krâsu ikonas
var tikt parâdîtas, lai norâdîtu skaòas spiediena
statusu un dzirdes bojâjumu riska lîmeòus.

(sarkans) Vairâk kâ
90 decibeli

Pârliecinieties, ka esat pieslçguði austiòas
atskaòotâjam.

Mûzikas atskaòoðanas izvçlnç piespiediet
.

Skaïuma izvçlne tiek parâdîta.

Skaïuma izvçlnç piespiediet , lai izvçlçtos
opcijas.

�

Pârslçgðanâs starp “Mâjas” izvçlni un
atskaòoðanas izvçlni

“Mâjas” izvçlnç:

[Now playing] [Last
played]

Atskaòoðanas izvçlnç:

Lai izvçlçtos tçmu ekrânam:

[Theme]

VIBE

> [Display settings]
> [Backlight timer]

Lai izietu no enerìijas taupîðanas reþîma:

Skaòas
spiediena
lîmenis

1.

2.

3.
“SafeSound”

Tçmas izvçle

�

�

Maksimâlais
ilgums

30 minûtes dienâ

(oranþs) 85-90 decibeli 2 stundas dienâ

(dzeltens) 80-85 decibeli 5 stundas dienâ

(zaïð) droðs Vairâk nekâ 5 stundas
dienâ

Taustiòu bloíçðana/atbloíçðana

Ekrâna ieslçgðana/izslçgðana

“SafeSound”

“SafeSound” lietoðana

Padoms

Padoms

�

�

�

1

2

Metodoloìija ir balstîta uz Eiropas normu
(50332-1/2).

Atsauces lîmeòi tiek novçrtçti pçc
minimâlajâm veselîbas un droðîbas
prasîbâm, ko nosaka Eiropas direktîva
2003/10/EC par trokðòiem, kam tiek
pakïautas personas.

Informâcijai par “SafeSound” (Droðâ
skaòa) opcijâm, skatiet nodaïu
“SafeSound” (25. lpp. skatiet nodaïu
“SafeSound”).

... Jûsu jaunais atskaòotâjs
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Atskaòotâja uzlâdçðana

Atskaòotâja ieslçgðana un
izslçgðana

Piezîme

Piezîme

�

�

�

Pieslçdzot VIBE atskaòotâju pie datora,
jums piedâvâ izvçlçties:

(Lâdçt un pârraidît) vai
(Lâdçt un atskaòot).

Ja izvçle netiek izdarîta, VIBE atskaòotâjs
automâtiski izvçlas iestatîjumu

(Lâdçt un pârraidît).

Pârlâdçjamâm baterijâm ir ierobeþots
uzlâdes ciklu skaits. Baterijas kalpoðanas
laiks un pârlâdçðanas ciklu skaits var
mainîties atkarîbâ no lietoðanas un
iestatîjumiem.

[Charge &
transfer] [Charge
& play]

[Charge &
transfer]

Automâtiskâ pârslçgðanâs gaidîðanas
reþîmâ un izslçgðanâs

VIBE
VIBE

Baterijas enerìijas lîmeòa indikators

Lai taupîtu VIBE atskaòotâja baterijas enerìiju un
palielinâtu atskaòoðanas laiku:

[Display settings]
[Backlight timer]

VIBE

atskaòotâjam ir iebûvçta baterija, ko var lâdçt
caur datora USB portu. Pieslçdziet atskaòotâju
pie datora, lietojot komplektâ iekïauto USB vadu.

Kad baterijas uzlâdes lîmenis ir zems,
parâdâs attiecîga zemas baterijas uzlâdes
lîmeòa ikoniòa.

Kad baterija ir uzlâdçta, parâdâs ikoniòa.

Iestatiet fona apgaismojuma taimeri
iespçjami minimâlam laikam: (uzejiet uz >

(Ekrâna iestatîjumi) >
(Fona apgaismojuma

taimeris).

Piespiediet un paturiet nospiestu , lîdz
atskaòotâjs ieslçdzas vai izslçdzas.

Atskaòotâjs var automâtiski pârslçgties gaidîðanas
reþîmâ, kâ arî izslçgties, taupot baterijas enerìiju.

Pçc 10 minûðu ilgas dîkstâves (netiek atskaòota
mûzika, netiek nospiests neviens taustiòð)
atskaòotâjs izslçdzas.

�

�

�

�

3. Darbîbas sâkðana



Mûzikas pârraidîðana uz atskaòotâju Mûzikas atraðana atskaòotâjâ

Mûzikas atraðana pçc dziesmas
informâcijas

Mûzikas atraðana pçc atskaòojamâ
saraksta

Mûzikas atraðana pçc faila mapes

“Superscroll”

Jûs varat pârraidît mûziku no sava datora mediju
bibliotçkas uz atskaòotâju ðâdos veidos:

Sinhronizçt saturu, lietojot programmu “Philips
Songbird” (skatiet nodaïu “Sinhronizçðana ar
datora mûzikas bibliotçku, lietojot programmu
“Philips Songbird”” 28. lpp.). Ar mediju
organizçðanas programmatûru jûs varat piekïût
tieðsaistes mûzikas veikaliem, veidot
atskaòojamos sarakstus vai rediìçt savas
mûzikas kolekcijas pçc dziesmu informâcijas.

Ar “pârneðanas” (“Drag and drop”) metodi
pârnest mûzikas failus “Windows Explorer”
programmâ. Ðâdi varat organizçt mapçs savas
mûzikas kolekcijas.

Pievienojiet atskaòotâju pie datora.

Datorâ, sadaïâ vai
,

Izvçlieties atskaòotâju un izveidojiet
failu mapes.

Datorâ ar “pârneðanas” (“Drag and drop”)
metodi pârnesiet mûzikas failus
atskaòotâja failu mapçs.

Pçc izvçles “pârnesiet” (“Drag and drop”)
failu mapes no datora uz atskaòotâju.

atskaòotâjâ jûs varat atrast mûziku pçc
dziesmu informâcijas, atskaòojamâ saraksta vai
failu mapes. Ar jûs varat âtri
pârskatît mûzikas bibliotçku pçc sâkumburta.

Sadaïâ dziesmas ir sakârtotas pçc metadatiem vai
ID3 tagiem daþâdâs izlasçs: (Visas
dziesmas), (Izpildîtâji), (Albumi)
vai (Þanri).

Dziesmas ir sakârtotas alfabçta secîbâ pçc
nosaukuma.

Dziesmas ir sakârtotas alfabçta secîbâ pçc
izpildîtâja.

Zem katra izpildîtâja vârda dziesmas ir
sakârtotas alfabçta secîbâ pçc albuma.

Dziesmas ir sakârtotas alfabçta secîbâ pçc
albumiem.

Dziesmas ir sakârtotas pçc þanriem pops,
roks u.c.

Sadaïâ atrodiet atskaòojamo
sarakstu, ko vçlaties pârraidît no datora mediju
bibliotçkas.

Sadaïâ atrodiet mûziku pçc faila mapes.

Atskaòotâja opciju saraksts sakârtots alfabçta
secîbâ. ïauj pârlûkot opcijas pçc to
sâkumburta.

VIBE

Mûzikas failu “pârneðana” (“Drag and drop”)
programmâ “Windows Explorer”

1. VIBE

2. “My Computer”
“Computer”

VIBE

3.
VIBE

VIBE

VIBE

“Superscroll”

[All songs]
[Artists] [Albums]

[Genres]

[All songs] (Visas dziesmas)

[Artists] (Izpildîtâji)

[Albums] (Albumi)

[Genres] (Þanri)

> [Playlists]

“Superscroll”

�

�

�

�

�

�

�

�

�
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4. Mûzika
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�

�

�

�

�

�

�

�

�

Piespiediet un paturiet nospiestu taustiòu
, lai izmantotu “Superscroll”.

Ekrânâ varat redzçt attiecîgâs opcijas
sâkumburtu.

Jûs varat sâkt atskaòot dziesmu, visu albumu vai
visas izpildîtâja dziesmas.

Lai sâktu dziesmas atskaòoðanu:

Izvçlieties dziesmu.

Piespiediet taustiòu , lai sâktu
atskaòoðanu.

Atskaòoðana sâkas no attiecîgâs dziesmas.

Izvçlieties albumu vai izpildîtâju.

Piespiediet (Atskaòot visu).

Piespiediet , lai sâktu atskaòoðanu.

Piespiediet taustiòu , lai pauzçtu un
atsâktu atskaòoðanu.

Lai atgrieztos iepriekðçjâ izvçlnç, piespiediet
.
Atskaòoðanas izvçlne parâdâs daþas
sekundes vçlâk.
Atskaòoðanas izvçlnç jûs varat redzçt
faila informâciju un atskaòoðanas
statusu.

Atskaòoðanas izvçlnç piespiediet .

Atkârtoti piespiediet .

Atskaòoðanas izvçlnç piespiediet un paturiet
nospiestu taustiòu .

Dziesmas atskaòoðanas laikâ jûs varat pârslçgties
uz izlasi, kurâ ir iekïauta attiecîgâ dziesma.

Atskaòoðanas izvçlnç piespiediet un
izvçlieties (Atskaòoðanas reþîmu).

Sadaïâ Atskaòot mûziku
no...) izvçlieties (... ðî
izpildîtâja), (...ðî albuma) vai

(... ðî þanra).
Jûs sâkat attiecîgâ izpildîtâja, albuma vai
þanra atskaòoðanu.

Atskaòoðanas izvçlnç piespiediet un
izvçlieties (Atskaòoðanas reþîms).

Sadaïâ (Atskaòot mûziku
no...) izvçlieties (Visas dziesmas).
Piespiediet .

Atskaòoðanas izvçlnç piespiediet , lai izvçlçtos
tâdas atskaòoðanas opcijas kâ atskaòoðanas reþîms,
skaòas iestatîjumi un izslçgðanâs taimeris (skatiet
nodaïu “Iestatîjumi” 25. lpp.).

Atskaòotâjâ jûs varat atrast ðâdus atskaòojamos
sarakstus:

atskaòojamos sarakstus, kurus esat
pârraidîjuði no datora mediju bibliotçkas;

trîs atskaòojamos sarakstus, kuriem jûs
varat pievienot dziesmas atskaòotâjâ.

Izvçlieties vai atskaòojiet dziesmu.

Dziesmu sarakstâ vai atskaòoðanas izvçlnç:

Piespiediet un izvçlieties
(Pievienot atskaòojamajam sarakstam).

Izvçlieties atskaòojamo sarakstu. Piespiediet
.
Jûs saglabâjat attiecîgo dziesmu
atskaòojamajâ sarakstâ.

�

�

�

�

�

�

1.

2.

Lai atskaòotu visu albumu vai visas izpildîtâja
dziesmas:

1.

2. > [Play all]

3.

Atskaòoðanas izvçlnç:

Lai regulçtu skaïumu:

Lai izvçlçtos mûzikas failu atskaòoðanas izvçlnç:

Lai âtri pârtîtu atpakaï vai uz priekðu vienu
dziesmu:

1.
[Play mode]

2. [Play music from...] (
[... this artists]

[... this album]
[... this genre]

Lai atskaòotu visas dziesmas atskaòotâjâ:

1.
[Play mode]

2. [Play music from...]
[All songs]

Lai pievienotu attiecîgo dziesmu:

1.

2.

[Add to playlist]

3.

�

�

�

�

�

Mûzikas atskaòoðana

Atskaòojamie saraksti

Mûzikas atskaòoðana no vienas kolekcijas

Atskaòoðanas opciju izvçle

Dziesmu pievienoðana atskaòojamajam
sarakstam

... Mûzika
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Lai pievienotu albumu vai izpildîtâju:

1.

2.

[Add to playlist]

3.

Attiecîgâs dziesmas dzçðana no atskaòojamâ
saraksta

1. > [Remove
from Playlist]

2.

Visu dziesmu dzçðana no atskaòojamâ saraksta

1.

2.
[Clear playlist]

3.

Lai dzçstu attiecîgo dziesmu atskaòoðanas laikâ:

[Delete]

Izvçlieties albumu vai izpildîtâju.

Albumu vai izpildîtâju sarakstâ:

Piespiediet un izvçlieties
(Pievienot atskaòojamajam sarakstam).

Izvçlieties atskaòojamo sarakstu. Piespiediet
.
Jûs saglabâjat attiecîgo albumu vai
izpildîtâju atskaòojamajam sarakstam.

Atskaòoðanas izvçlnç piespiediet
(Izslçgt no atskaòojamâ

saraksta).

Izvçlieties atskaòojamo sarakstu. Piespiediet
.
Jûs dzçðat attiecîgo dziesmu no izvçlçtâ
atskaòojamâ saraksta.

Uzejiet uz atskaòojamâ saraksta.

Opciju izvçlnç piespiediet un izvçlieties
(Dzçst no atskaòojamâ

saraksta).

Piespiediet .
Jûs dzçðat visas dziesmas no atskaòojamâ
saraksta.

Atskaòoðanas izvçlnç piespiediet un
izvçlieties (Dzçst).

Attiecîgâ dziesma tiek izdzçsta no
atskaòotâja.

�

�

�

�

�

�

�

�

�

Dziesmu dzçðana no atskaòojamâ
saraksta

Dziesmu dzçðana no atskaòotâja

... Mûzika



Uzejiet uz (Audiogrâmatas), lai
atskaòotu grâmatas audio formâtâ, kuras esat
lejupielâdçjuði no mâjaslapas www.audible.com.

No mâjaslapas www.audible.com lejupielâdçjiet un
instalçjiet savâ datorâ programmatûru

.

Ar ðo programmatûru jûs varat:

lejupielâdçt audiogrâmatas no mâjaslapas
www.audible.com sava datora audiogrâmatu
bibliotçkâ;

sinhronizçt audiogrâmatas savâ atskaòotâjâ.

Pieslçdziet savu datoru pie interneta.

No mâjaslapas www.audible.com lejupielâdçjiet
programmatûru MP3/MP4

atskaòotâjiem.

Instalçjiet programmatûru savâ datorâ.

Iestatîðanas izvçlnç izvçlieties
no klausâmo

ierîèu lejup izvelkamâ saraksta.

Lai pabeigtu instalçðanu, sekojiet lîdzi
instrukcijâm un izpildiet tâs.

Pieslçdziet savu datoru pie interneta.

Datorâ startçjiet programmatûru
“AudibleManager”.

Programmâ uzklikðíiniet
uz taustiòa, lai pieslçgtos
mâjaslapai www.audible.com.

Izvçlieties un lejupielâdçjiet audiogrâmatas:

Reìistrçjieties savâ kontâ mâjaslapâ
www.audible.com;

Lejupielâdçjiet audiogrâmatas vai
formâtâ.

Lejupielâdçtâs audiogrâmatas tiek
automâtiski pievienotas jûsu

bibliotçkai.

Datorâ startçjiet programmatûru
.

Pievienojiet atskaòotâju pie datora. Pagaidiet,
lîdz programmatûra
atpazîst atskaòotâju.

Programmâ uzklikðíiniet
uz (Pievienot ierîci).

Pirmo reizi pieslçdzot atskaòotâju pie
, aktivizçjiet atskaòotâju,

kâ tas tiek prasîts.

> [Audiobooks]

“AudibleManager”

1.

2.
“AudibleManager”

3.

“Philips
GoGear (selected models)”

1.

2.

3. “AudibleManager”
“My Library Online”

4.

“AudibleManager”

1.
“AudibleManager”

2.
“AudibleManager”

3. “AudibleManager”
“Add to Device”

“AudibleManager”

�

�

�

�

�

�

�

�

Audiogrâmatu sinhronizçðana ar
atskaòotâju

Programmas “AudibleManager”
instalçðana datorâ

Audiogrâmatu lejupielâdçðana datorâ

Sinhronizçðana ar atskaòotâju

16

5. Audiogrâmatas
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Lai pârbaudîtu uz atskaòotâju pârraidîtâs
audiogrâmatas:

“AudibleManager”

“Refresh
Device”.

> [Audiobooks]

[Books] (Grâmatas)

[Authors] (Autori)

1.

2.

Atskaòoðanas izvçlnç:

Lai pârlçktu virsrakstiem vai nodaïâm
atskaòoðanas laikâ:

1.
[Navigation mode]

[Titles] [Section]

2.

Lai pievienotu atzîmi:

1.
[Bookmarks] > [Add

Bookmark]

2.

Lai atskaòotu no atzîmçtâ atskaòoðanas laika:

[Bookmarks] > [Go to bookmark]

Lai dzçstu atzîmi:

[Bookmarks] > [Delete
bookmark]

[Delete Audiobook]

Skatiet atskaòotâja logu programmatûrâ
.

Ja nepiecieðams, uzklikðíiniet uz

Sadaïâ (Audiogrâmatas)
audiogrâmatu faili ir sakârtoti pçc grâmatu
virsrakstiem vai autoriem.

Grâmatas ir sakârtotas alfabçta secîbâ pçc
grâmatu virsrakstiem.

Grâmatas ir sakârtotas alfabçta secîbâ pçc
autoriem.

Izvçlieties grâmatu.

Piespiediet , lai sâktu atskaòoðanu.
Atskaòoðanas izvçlnç jûs varat redzçt
grâmatas informâciju un atskaòoðanas
statusu.

Piespiediet , lai pauzçtu un atsâktu
atskaòoðanu.

Lai atgrieztos iepriekðçjâ izvçlnç, piespiediet
.

Atskaòoðanas izvçlnç piespiediet >
(Navigâcijas reþîms).

Izvçlieties (Virsraksti) vai
(Nodaïa).

Atskaòoðanas izvçlnç piespiediet .

Audiogrâmatâs jûs varat ievietot lîdz 10 atzîmçm.
Sâciet atskaòoðanu no atzîmçtâ atskaòoðanas laika,
kâ nepiecieðams.

Atskaòoðanas izvçlnç piespiediet un
izvçlieties (Atzîmes)

(Pievienot atzîmi).

Izvçlieties atraðanâs vietu.
Paðreizçjais atskaòoðanas laiks ir
pievienots atzîmju sarakstam.

Atskaòoðanas izvçlnç piespiediet un
izvçlieties
(Doties uz atzîmi). Izvçlieties opciju.

Atskaòoðana sâkas no izvçlçtâ
atskaòoðanas laika.

Atskaòoðanas izvçlnç spiediet un
izvçlieties

(Dzçst atzîmi). Izvçlieties opciju.
Atskaòoðanas laiks tiek izdzçsts no
atzîmju saraksta.

Atskaòoðanas izvçlnç piespiediet >
(Dzçst audiogrâmatu).

Attiecîgâ audiogrâmata tiek izdzçsta no
atskaòotâja.

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Audiogrâmatu atraðana atskaòotâjâ

Audiogrâmatu atskaòoðana

Atzîmju lietoðana

Audiogrâmatu dzçðana no
atskaòotâja

... Audiogrâmatas
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Video pârraidîðana uz atskaòotâju

Programmas “Philips Media Converter”
instalçðana

Programmas “Philips Media Converter”
lietoðana

Piezîme

Piezîme

�

�

Lai ieinstalçtu programmatûru, atíeksçjiet,
ka piekrîtat licences noteikumiem.

Lai ieinstalçtu programmatûru, atíeksçjiet,
ka piekrîtat licences noteikumiem.

Jûs varat pârraidît video uz atskaòotâju divos
veidos:

Lietojot programmu
. Lietojot video pârveidoðanas

programmatûru, jûs varat pârveidot video
tâdâ faila formâtâ, ko atbalsta atskaòotâjs un
pârraidît to uz atskaòotâju.

“Pârnesiet” (“Drag and drop”) video failus
(.smv failus), lietojot programmu Windows
Explorer. Ðâdâ veidâ jûs savas video izlases
varat sakârtot mapçs.

Pirmo reizi pievienojot atskaòotâju pie datora,
parâdâs logs:

Izvçlieties savu valodu un valsti;

Sekojiet lîdzi ekrânâ redzamajâm instrukcijâm
un izpildiet tâs, lai pabeigtu instalçðanu.

Ja logs neparâdâs automâtiski:

Uz atskaòotâja pârliecinieties, ka esat
izvçlçjuðies ðâdas opcijas:

Sadaïâ , izvçlieties opciju
(Iespçjot).

Uz datora izvçlieties sadaïu
(Windows XP/Windows 2000)/
(Windows Vista/Windows 7).

draiveris ir parâdîts.

Programmas
instalçðanai, sadaïâ draiveris
izdariet dubultklikðíi uz .

Uz datora startçjiet programmu
.

Pievienojiet atskaòotâju datoram, lietojot USB
vadu.

Uzgaidiet lîdz programma
atpazîst atskaòotâju.

�

�

�

�

“Philips Media
Converter”

Programmas “Philips Media Converter”
instalçðana pirmo reizi

VIBE

1.

2.

1.

> [CD installer]
[Enable]

2. My Computer
Computer

Philips Songbird

3. “Philips Media Converter”
Philips Songbird

PMCsetup.exe

1. “Philips Media
Converter”

2.

“Philips Media
Converter”

�

6. Video
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3. “Philips Media Converter”

4. “Philips Media Converter”

Video atraðana pçc faila nosaukuma

Video atraðana pçc faila mapes

1.

2.

Atskaòoðanas izvçlnç:

Lai izvçlçtos video failu atskaòoðanas izvçlnç:

Lai âtri attîtu vai pârtîtu attiecîgâ video robeþâs:

1.

2.

[Delete video]

Programmâ
pievienojiet video savai datora bibliotçkai.

Uzklikðíiniet uz .
Video tiek pievienoti sarakstam
pârveidoðanai un pârraidîðanai.

Lai dzçstu video no failu saraksta,
uzklikðíiniet uz .

Programmâ sâciet
failu pârveidi un pârraidi.

Uzklikðíiniet uz .

Uzejiet uz ..
Video faili ir sakârtoti sarakstâ alfabçta
secîbâ pçc to nosaukumiem.

Uzejiet uz .
Video faili ir sakârtoti pçc failu mapçm kâ
datorâ.

Izvçlieties video.

Piespiediet , lai sâktu atskaòoðanu.
Video tiek atskaòots ainavas skatîjumâ.

Piespiediet , lai pauzçtu vai atsâktu
atskaòoðanu.

Atkârtoti piespiediet .

Atskaòoðanas izvçlnç piespiediet un paturiet
.

Izvçlieties vai atskaòojiet video.

Video sarakstâ vai atskaòoðanas izvçlnç:

piespiediet un izvçlieties
(Dzçst video).

Attiecîgais video tiek izdzçsts no
atskaòotâja.

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Video atraðana atskaòotâjâ

Video atskaòoðana

Video dzçðana no atskaòotâja

... Video
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Attçlu pievienoðana atskaòotâjam

Attçlu atraðana atskaòotâjâ

Attçlu skatîðanâs

Attçlu dzçðana no atskaòotâja

Slîdrâdes sâkðana

Atskaòoðanas opciju izvçlçðanâs

1. VIBE

2. My Computer Computer

VIBE

3.
VIBE

VIBE

Attçlu atraðana pçc faila nosaukuma

Attçlu atraðana pçc faila mapes

Atskaòoðanas izvçlnç:

[Backlight timer]

[Slideshow settings]

[Time per slide]

[Repeat]

[Shuffle]

1.

2.

[Delete picture]

Pievienojiet atskaòotâju datoram.

Datorâ, sadaïâ vai :

Izvçlieties un izveidojiet failu mapes.

Datorâ “paceliet un pârnesiet” failus uz failu
mapçm sadâïâ .

Alternatîva, “paceliet un pârnesiet” failu
mapes no datora uz .

Uzejiet uz .
Attçlu faili ir parâdîti sarakstâ alfabçta
secîbâ pçc to nosaukumiem.

Uzejiet uz .
Attçlu faili ir sakârtoti pçc failu mapçm kâ
datorâ.

Attçlu sarakstâ piespiediet un ,
lai izvçlçtos attçlu.

Attçls tiek parâdîts ainavas skatîjumâ.

Piespiediet , lai izvçlçtos attçlu.

Laikâ, kad skatâties attçlu, piespiediet ,
lai sâktu slîdrâdi.

Attçli tiek parâdîti viens pçc otra.

Atskaòoðanas izvçlnç piespiediet , lai izvçlçtos
atskaòoðanas opcijas.

(Fona apgaismo-
juma taimeris) automâtiski izslçdzas.

Sadaïâ (Slîdrâdes iestatîjumi)
izvçlieties jûsu opcijas slîdrâdei:

(Slaida laiks) diviem slaidiem.

(Atkârot) Atskaòojiet attiecîgâs mapes
attçlus atkâroti.

(Jaukta secîba) attçlus jauktâ secîbâ.

Izvçlieties vai atskaòojiet attçlu.

Attçlu sarakstâ vai atskaòoðanas izvçlnç:

piespiediet un izvçlieties
(dzçst attçlu).

Attiecîgais attçls tiek izdzçsts no
atskaòotâja.

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Izvçlieties lielumu. Pçc izvçlçtâ
laika perioda ekrâns

Izvçlieties laika intervâlu starp

Atskaòojiet attiecîgâs mapes

7. Attçli
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Piezîme

Padoms

�

�

Lai uztvertu radiostacijas, pieslçdziet pie
atskaòotâja komplektâ iekïautâs austiòas.
Austiòas darbojas kâ antena. Labâkas
uztveres nodroðinâðanai pârvietojiet
austiòu vadu daþâdos virzienos.

Pârceïoties uz citu pilsçtu vai valsti, labâkai
radiostaciju uztverðanai vçlreiz veiciet
automâtisko uztverðanu.

Radiostaciju uztverðana

Uztverto radiostaciju saglabâðana

Automâtiskâ radiostaciju uztverðana

1. > [Auto tune]

2.

Lai izvçlçtos saglabâtu radiostaciju atskaòoðanas
izvçlnç:

Manuâlâ radiostaciju uztverðana

1. > [Manual tune]

2.

VIBE

1.

2.
[Save to preset]

3.

Lai dzçstu attiecîgo saglabâto radiostaciju:

1.
[Clear

preset]

2.

3. [Yes]

Lai dzçstu visas saglabâtâs radiostacijas:

1.
[Clear all presets]

2. [Yes]

Pirmo reizi uztverot radio, meklçjiet radiostacijas
automâtiskajâ uztverðanas reþîmâ.

“Mâjas” izvçlnç uzejiet uz
(Automâtiskâ uztverðana).

Atskaòotâjâ varat saglabât 30 radiostacijas.

Atkârtoti piespiediet vai , lai izvçlçtos
saglabâto radiostaciju. Piespiediet , lai
sâktu atskaòoðanu.

Atkârtoti piespiediet vai .

Sameklçt frekvenci vai radiostaciju varat arî
manuâlajâ uztverðanas reþîmâ.

“Mâjas” izvçlnç uzejiet uz
(Manuâlâ uztverðana).

Tiek atskaòota pçdçjâ atskaòotâ
radiostacija.

Atskaòoðanas izvçlnç piespiediet un paturiet
nospiestu vai .

Jûs uztverat nâkamo radiostaciju, kas ir
vistuvâk esoðajai frekvencei.

Precîzai uztverðanai atkârtoti piespiediet
vai .

atskaòotâjâ jûs varat saglabât 30 radiostacijas.

Uztveriet radiostaciju.

Atskaòoðanas izvçlnç piespiediet un
izvçlieties (Saglabât atmiòâ).

Piespiediet vai , lai izvçlçtos pozîciju
radiostacijas saglabâðanai. Piespiediet .

Attiecîgâ radiostacija ir saglabâta izvçlçtajâ
pozîcijâ.

Atskaòoðanas izvçlnç vai saglabâto radiostaciju
sarakstâ piespiediet un izvçlieties

(Dzçst saglabâto radiostaciju).
Saglabâto radiostaciju sarakstâ attiecîgâ
radiostacija ir izvçlçta.

Piespiediet vai , lai izvçlçtos saglabâto
radiostaciju.

Piespiediet . Izvçlieties (Jâ).
Attiecîgâ radiostacija tiek izdzçsta no
saglabâto radiostaciju saraksta.

Saglabâto radiostaciju sarakstâ piespiediet >
(Dzçst visas saglabâtâs

radiostacijas).

Izvçlieties (Jâ).
Visas radiostacijas tiek izdzçstas no
saglabâto radiostaciju saraksta.

�

�

�

�

�

�

�

�

�

�

�

�

8. FM radio
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... FM radio

FM radio klausîðanâs
1. > [Presets]

2.

[Presets]

Lai regulçtu skaïumu:

Lai atslçgtu vai atkal pieslçgtu skaòu radio
atskaòoðanai:

Uzejiet uz (Saglabâtâs
radiostacijas).

Piespiediet vai , lai izvçlçtos saglabâto
radiostaciju. Piespiediet , lai sâktu
atskaòoðanu.

Piespiediet , lai izvçlçtos citu saglabâto
radiostaciju no sadaïas .
Piespiediet , lai sâktu atskaòoðanu.

Atskaòoðanas izvçlnç piespiediet vai ,
lai izvçlçtos saglabâto radiostaciju.

Atskaòoðanas izvçlnç piespiediet vai .

Atskaòoðanas izvçlnç piespiediet .

�

�

�

�

�

�

�
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Uzejiet uz sadaïas > [FM Recording] (FM
ierakstîðana), lai klausîtos radioprogrammas, kuras
jûs varat ierakstît no FM radio.

Uztveriet radiostaciju.

Atskaòoðanas izvçlnç izvçlieties
(Sâkt FM radio ierakstîðanu).

Jûs sâkat ierakstîðanu no FM radio.

Piespiediet , lai pârslçgtos starp pauzi un
ierakstîðanu. Piespiediet , lai beigtu
ierakstîðanu.

Piespiediet , lai saglabâtu ierakstu.
Ieraksti ir saglabâti atskaòotâjâ, sadaïâ >

(FM radioieraksti). (Faila
nosaukuma formâts: FMRECXXX.WAV, kur
XXX ir ieraksta numurs, kas tiek pieðíirts
automâtiski).

Sadaïâ > (FM ierakstu
bibliotçka) > izvçlieties ierakstu.

Piespiediet , lai atskaòotu savu ierakstu.

Atkârtoti piespiediet vai .

Atskaòoðanas izvçlnç piespiediet un paturiet
nospiestu vai .

Izvçlieties vai atskaòojiet ierakstu.

Ierakstu sarakstâ vai atskaòoðanas izvçlnç

piespiediet un izvçlieties (dzçst).
Attiecîgais ieraksts tiek izdzçsts no
atskaòotâja.

Sadaïâ (FM ieraksti)
izvçlieties Dzçst visu).

Pieslçdziet atskaòotâju pie sava datora.

Datorâ, sadaïâ vai
:

Izvçlieties ;

atskaòotâjâ izvçlieties ierakstus mapç
(ieraksti) .

“Pârnesiet” (“Drag and drop”) ierakstu failus
kur vçlaties datorâ.

1.

2. [Start FM
radio recording]

3.

4. [Yes]

[FM recording]

1. [FM Recordings]

2.

Lai izvçlçtos failu atskaòoðanas izvçlnç:

Lai âtri attîtu vai pârtîtu vienu failu:

1.

2.

[Delete]

Lai dzçstu visus ierakstus no atskaòotâja:

[FM Recording]
[Delete all] (

1. VIBE

2. “My Computer”
“Computer”

VIBE

VIBE
“Recordings” > FM

3.

�

�

�

�

�

�

�

�

�

�

�

Ierakstîðana no FM radio

FM radio ierakstu klausîðanâs

Ierakstu dzçðana no atskaòotâja

Jûsu ierakstu augðupielâdçðana
datorâ

Piezîme

� FM radio ierakstîðana ir pieejama tikai
daþiem modeïiem. To, kuras atskaòotâja
funkcijas ir pieejamas jums, pârbaudiet
atskaòotâja izvçlnç.

9. Ierakstîðana
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10. Mapju pârskats

Uzejiet uz sadaïu , lai apskatîtu un atskaòotu
mediju failus no atskaòotâja mediju bibliotçkas.

(Mûzika): mûzikas failiem, ko jûs
sinhronizçjat atskaòotâjâ, lietojot programmu

;

(Video): video failiem, ko jûs esat
sinhronizçjuði atskaòotâjâ, lietojot programmu

;

(Atskaòojamie saraksti):
atskaòojamajiem sarakstiem, ko jûs sinhronizçjat
atskaòotâjâ, un atskaòojamajiem sarakstiem, ko jûs
izveidojat atskaòotâjâ;

(Pakalpojums): audiogrâmatâm, ko jûs
sinhronizçjat atskaòotâjâ, lietojot programmu

”.

(Ieraksti): *FM ierakstiem, ko jûs
veidojat atskaòotâjâ.

Atrodiet failus, kâ jûs tos bijât organizçjuði
“Windows Explorer” programmâ datorâ.

“Music”

“Philips Songbird”

“Video”

“Philips SongBird”

“Playlists”

“Service”

“AudibleManager

“Recordings”

Lai atrastu failus, kas pârraidîti, lietojot
programmu “Windows Explorer”:

�

Piezîme

� * FM radio ierakstîðana ir pieejama tikai
daþiem modeïiem. To, kuras atskaòotâja
funkcijas ir pieejamas jums, pârbaudiet
atskaòotâja izvçlnç.
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Izvçlnç izvçlieties savas opcijas atskaòotâjam.

Nospiediet , lai izvçlçtos opciju.

Nospiediet , lai apstiprinâtu izvçli.

Sadaïâ (Atskaòoðanas reþîms)
izvçlieties atskaòoðanas reþîmus mûzikas
atskaòoðanai:

Pârslçdzas uz attiecîgâs dziesmas kolekciju.

(Ieslçgts): Visas dziesmas, kas saglabâtas
attiecîgajâ mapç, atskaòo jauktâ secîbâ.

Ja abi iestatîjumi un ir
aktivizçti:

Visas dziesmas/ieraksti attiecîgajâ mapç tiek
atkârtoti jauktâ secîbâ.

Sadaïâ (Skaòas iestatîjumos)
izvçlieties skaòas iestatîjumu opcijas:

(Pilnskaòa) zûd mûzikas kompresijas
rezultâtâ (piemçram, MP3,
WMA).

(Stabilizators) izvçlçts.

“SafeSound” darbojas kopâ ar iezîmi atbalstoðâm
austiòâm. Precîzai mçrîjuma veikðanai lietojiet
komplektâ iekïautâs austiòas vai austiòas, kuras
norâdîtas sarakstâ.

Sadaïâ (Izvçlçties austiòas)
izvçlieties lietotâs austiòas.

Lietojiet iestatîjumu [Parental control] (Vecâku
kontrole), lai ierobeþotu Jûsu noteikto skaïuma
lîmeni.

Pârliecinieties, ka esat ieslçguði “SafeSound”
(25. Lpp. skatiet nodaïu : “Aktivizçðana”).

Sadaïâ (Vecâku kontrole)
izvçlieties (Ieslçgts).

Ievadiet paroli.

Sadaïâ (Skaïuma limits) iestatiet
savu skaïuma limitu.

Ievadiet paroli, ja nepiecieðams.

Piespiediet , lai izvçlçtos skaïuma limitu.

Piespiediet , lai to apstiprinâtu.

Sadaïâ (Paroles maiòa) ievadiet
un iestatiet paroli kâ prasîts.

Sadaïâ (Aktivizçt) izvçlieties
(Ieslçgts).

Jûs pârslçdzaties uz
funkciju.

1.

2.

[Play mode]

[Play music from...] (Atskaòot mûziku no...)

Atkârtot [Repeat] (Atkârtot)

Atskaòoðana jauktâ secîbâ [Shuffle]:

[On]

[Repeat all] [Shuffle]

[Sound settings]

[Select earphone]

Paroles iestatîðana

1.

2. [Parental control]
[On]

3.
1. Atkârtoti piespiediet taustiòus vai

piespiediet un paturiet taustiòus ,
lai ievadîtu ciparus.

2. Piespiediet taustiòus , lai
izvçlçtos ievades pozîciju.

3. Piespiediet , lai to apstiprinâtu.

Skaïuma limita iestatîðana

[Volume limit]

1.

2.

3.

Paroles maiòa

[Change password]

[Activate] [On]

“SafeSound”

�

�

�

�

�

�

�

�

�

[Repeat 1] :

[Repeat all] :

[FullSound]

[Equalizer]

(Atkârtot 1) Atkârto attiecîgo
dziesmu.

(Atkârtot visu) Atkârto visas
dziesmas, kas saglabâtas attiecîgajâ mapç.

Atjauno skaòas detaïas, kas

Definç skaòas iestatîjumus, kâ

Vecâku kontrole

Aktivizçðana

�

Atskaòoðanas reþîms

Skaòas iestatîjumi

Piezîme

� Stabilizatori tiek izslçgti, ja jûs izvçlaties
pilnskaòas iestatîjumu ( ).FullSound

“SafeSound” (Droðâ Skaòa)

11. Iestatîjumi



26

Izslçgðanâs taimeris

Ekrâna iestatîjumi

Slîdrâdes iestatîjumi

Valoda

Datora savienojuma izvçle

Ekrâna izslçgðanâs taimeris

Ekrâna saudzçtâjs

Padoms

� Strâvas taupîðanas nolûkâ izvçlieties îsu
laika periodu.

Ieslçdziet izslçgðanâs taimeri. atskaòotâjs var
izslçgties pçc noteikta laika.

Sadaïâ (Izslçgðanâs taimeris)
> (Iestatît izslçgðanâs
taimeri) izvçlieties opciju. Piespiediet .

Pçc izvçlçtâ laika ierîce automâtiski
izslçdzas.

Izvçlieties ;

Alternatîva: mûzikas atskaòoðanas izvçlnç
piespiediet .

Jûs varat redzçt laiku, kas atlicis lîdz
brîdim, kad ierîce izslçgsies.

Sadaïâ (Ekrâna
iestatîjumi) (Tçma) iestatîjumâ
izvçlieties ekrâna tçmu.

Ekrâns pârslçdzas dîkstâves reþîmâ, ja VIBE
atskaòotâjs netiek izmantots. Pçc noteikta laika
dîkstâves reþîmâ ekrâns automâtiski izslçdzas. Lai
taupîtu baterijas enerìiju, iestatiet îsu laika periodu
dîkstâves reþîmam.

No Mâjas izvçlnes, izvçlieties
(Displeja iestatîjumi)

(Fona apgaismojuma taimeris).

Izvçlieties laika periodu dîkstâves reþîmam.
Pçc izvçlçtâ laika perioda dîkstâves reþîmâ
ekrâns automâtiski izslçgsies.

Piespiediet jebkuru taustiòu.

Ja esat izvçlçjuðies ekrâna saudzçtâju, tas parâdâs
uz ekrâna dîkstâves reþîma laikâ pçc iepriekð
noteikta laika perioda.

No Mâjas izvçlnes, izvçlieties
(Displeja iestatîjumi)

(Ekrâna saudzçtâjs).

Sadaïâ nospiediet vai un
, lai izvçlçtos opciju.

(Neviens) Râda tukðu ekrânu.

(Digitâls pulkstenis)

(Albuma
noformçjums) ja pieejams, CD vâka

noformçjumu.

(Ekrâns izslçgts)

(Demonstrâcijas
reþîms)

Piespiediet jebkuru taustiòu.

Izvçlas laika intervâlu starp diviem slaidiem.

Ja ieslçgts, atskaòo visus slaidus atkârtoti.

Ja ieslçgts, atskaòo visus slaidus jauktâ
secîbâ.

Sadaïâ (Valoda) jûs varat mainît valodu.

Sadaïâ (Datora
savienojuma izvçle) izvçlieties savienojumu, ko
lietojat atskaòotâja pievienoðanai datoram.
Atskaòotâjs atïauj piekïuvi datoram, lietojot USB
Mass Storage Class (MSC) protokolu vai Media
Transfer Protocol (MTP) protokolu.

VIBE

[Sleep timer]
[Set sleep timer...]

Pçc izslçgðanâs taimera ieslçgðanas:

> [Sleep timer]

> [Sleep timer]

[Theme] (Tçma)

[Display settings]
> [Theme]

Lai iestatîtu laika periodu dîkstâves reþîmam:

1. > [Display
settings] > [Backlight
timer]

2.

Lai izietu no enerìijas taupîðanas reþîma:

Lai izvçlçtos ekrâna saudzçtâju:

1. > [Display
settings] > [Screensaver]

2. [Screensaver]

[None]

[Digital clock]

[Album art]

[Screen off]

[Demo mode]

Lai izietu no ekrâna saudzçtâja reþîma:

[Time per slide] (Slaida laiks)

[Repeat] (Atkârot)

[Shuffle] (Jaukta secîba)

[Language]

[PC connection preference]

�

�

�

�

�

�

�

�

�

� �

�

�

�

Râda laiku ciparu formâtâ.

Râda attiecîgâs dziesmas vai
pçdçjâs atskaòotâs dziesmas,

Ekrâns izslçdzas.

Râda atskaòotâja galvenâs
iezîmes

... Iestatîjumi
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[MSC]
Philips SongBird

Philips
Songbird

[MTP]

Philips Songbird.

[Information]

Informâcija par atskaòotâju [Player information]

[Model]

[Firmware version]

[Support site]

[Disk space] (Diska ietilpîba)

[Free space]

[Total space]

[Songs]

[Pictures]

[Videos

[File type supported] (Atbalstîtie failu tipi)

[Music]

[Pictures]

[Videos]

[Format device] (
[Yes]

[Factory settings]

[MSC] >
[PC connection preference], [CD installer]

CD installer]
[Enable]

“Philips Songbird”
“Philips Songbird”

*Ïauj atskaòotâjam darboties
arî kâ draive-
rim. Uzklikðíiniet uz

draivera, lai sâktu pro-
grammas instalçðanu datorâ.

Laikâ, kad notiek sinhronizçða-
na ar atskaòotâju, ïauj pret
kopçðanu aizsargâtu mûziku
konvertçt atskaòojamos
formâtos, lietojot programmu

Sadaïâ (Informâcija) noskaidrojiet
ðâdu informâciju par ierîci:

(Modelis) Pilns produkta nosaukums.
Pârbaudiet pilnu ierîces
nosaukumu, kad atjauninât
programmaparatûru no
atbalsta lapâm

(Programm -
tûras versija) tûras versiju, kad atjauninât

programmaparatûru no
atbalsta lapâm

(Brîvâ vieta)

(Kopçjâ ietilpîba)

(Dziesmas) Atmiòas izmçrs, ko aizòem
atskaòotâjâ saglabâtâs
dziesmas

(Attçli) Atmiòas izmçrs, ko aizòem
atskaòotâjâ saglabâtie attçli

(Video)] Atmiòas izmçrs, ko aizòem
atskaòotâjâ saglabâtie video

(Mûzika) Atskaòotâja atbalstîtie mûzikas
failu formâti

(Attçli) Atskaòotâja atbalstîtie attçlu
failu formâti

(Video) Atskaòotâja atbalstîtie video
failu formâti

Formatçjot atskaòotâju, jûs izdzçsîsit visus
atskaòotâjâ saglabâtos datus.

Izvçlieties Formatçt ierîci)
un tad (Jâ), lai apstiprinâtu savu izvçli.

Sadaïâ (Rûpnîcas iestatîjumi) var
atjaunot atskaòotâja rûpnîcas iestatîjumus. Uz
atskaòotâju pârraidîtie faili netiks bojâti.

Ja sadaïâ esat izvçlçjuðies iestatîjumu
iespçja

(CD uzstâdîtâjs) ir parâdîta.

Sadaïâ [ (CD uzstâdîtâjs) izvçlieties
(Ieslçgt), lai ïautu atskaòotâjam darboties

kâ draiverim. Uzklikðíiniet
divreiz uz draivera, lai sâktu
programmas instalçðanu datorâ.

Paðreizçjâs programmatûras
apara versija. Pârbaudiet programma-

Tîmekïa lapas, kas nodroðina
(Atbalsts atbalstu ierîcei
mâjaslapâs)

Pieejamâ vieta diskâ

Atmiòas izmçrs

�

Padoms

Padoms

�

�

*Pârliecinieties, ka sadaïâ
esat izvçlçjuðies iestatîjumu .

Pçc atskaòotâja laboðanas CD-ROM
nodalîjums un “Philips Songbird”
instalçtâjfails ir izdzçsts no atskaòotâja
(Skatiet nodaïu “Atskaòotâja laboðana,
lietojot programmu “Philips Songbird””
37. lpp.). Atskaòotâjâ ir pieejams vairâk
vietas.

> CD-ROM
[Enable]

Informâcija
Ierîces formatçðana

Rûpnîcas iestatîjumi

CD uzstâdîtâjs

... Iestatîjumi
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Ar programmu jûs varat veikt
ðâdas darbîbas:

Organizçt savas mûzikas kolekcijas datorâ;

Sinhronizçt atskaòotâju ar sava datora
mûzikas bibliotçku;

Reìistrçt atskaòotâju mâjaslapâ
www.philips.com/welcome;

Atjauninât VIBE atskaòotâja programmatûru
(Skatiet nodaïu “Programmatûras
atjauninâðana, lietojot programmu “Philips
Songbird”” 36. lpp.);

Labot VIBE atskaòotâju (Skatiet nodaïu
“Atskaòotâja laboðana, lietojot programmu
“Philips Songbird”” 37. lpp.).

Pirmo reizi pievienojot atskaòotâju pie datora,
parâdâs logs:

Izvçlieties savu valodu un valsti;

Sekojiet lîdzi ekrânâ redzamajâm instrukcijâm
un izpildiet tâs, lai pabeigtu instalçðanu.

Ja logs neparâdâs automâtiski:

Pârliecinieties, ka atskaòotâjâ esat izvçlçjuðies
ðâdas opcijas:

izvçlnç (CD uzstâdîtâjs)
izvçlieties (Iespçjot).

Datorâ izvçlieties (“Windows
XP”/ “Windows 2000”)/
(“Windows Vista”/”Windows 7”).

draiveris parâdâs.

Lai sâktu instalçðanu, uzklikðíiniet dubultklikðíi
uz draivera.

Jûs varat izvçlçties, lai visi mediju faili automâtiski
tiktu pievienoti jûsu bibliotçkai, kad kopçjat tos
mapç. Ieteicams izveidot centrâlo mapi. Programma

iestata centrâlo mapi kâ
pârskata mapi. Katru reizi startçjot programmu

, dziesmas tiek
pievienotas/dzçstas no programmas

atkarîbâ no tâ, vai tâs ir ievietotas
centrâlajâ mapç vai dzçstas no tâs.

Izveidojiet datorâ centrâlo mapi, lai saglabâtu tajâ
visus mûzikas failus, piemçram, D:/Songbird media.

“Philips Songbird”

VIBE

VIBE

“Philips Songbird” programmatûras instalçðana
pirmo reizi

VIBE

1.

2.

1.

> [CD installer]
[Enable]

2. “My Computer”
”Computer”

“Philips Songbird”

3.
“Philips Songbird”

“Philips Songbird”

“Philips Songbird”
“Philips

Songbird”

�

�

�

�

�

�

�

Centrâlâs mapes izveidoðana

Programmas “Philips Songbird”
instalçðana

Mediju failu iegûðana no datora

Piezîme

Piezîme

�

�

Lai ieinstalçtu programmatûru, atíeksçjiet,
ka piekrîtat licences noteikumiem.

Lai ieinstalçtu programmatûru, atíeksçjiet,
ka piekrîtat licences noteikumiem.

Pârskata mapes iestatîðana

12. Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”
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Pirmo reizi startçjot:

Lai iestatîtu “iTunes” mediju mapi:

Lai iestatîtu pârskata mapi:

Pirmo reizi datorâ startçjot programmu
un importçjot esoðos mediju failus

programmâ ”, sekojiet lîdzi
instrukcijâm un izpildiet tâs:

Izvçlieties “iTunes” mediju mapi, lai
importçtu esoðo “iTunes” bibliotçku;

Izvçlieties centrâlo mapi, lai skençtu un
importçtu esoðos mûzikas failus.

Centrâlâ mape tiek iestatîta kâ pârskata
mape programmâ .

Programmâ uzejiet uz

Izvçlieties un tad
cilni.

Apstipriniet savu bibliotçkas atraðanâs vietu un
opcijas.

Uzklikðíiniet uz taustiòa
blakus bibliotçkas atraðanâs vietai.

Programmatûra importç “iTunes”
bibliotçku programmâ .

Programmâ pârskata mapi
iestatiet ðâdi:

Izvçlieties .

vçlnç izvçlieties
un tad cilni.

izvçlnç ieklikðíiniet izvçles
logâ, kâ tas parâdîts.

Uzklikðíiniet uz un izvçlieties
centrâlo mapi (piem., D:/Songbird media) kâ
pârskata mapi.

Programmâ mediju
faili tiek pievienoti vai izdzçsti atkarîbâ no
tâ, vai tie ir ievietoti centrâlajâ mapç vai
dzçsti no tâs.

“Philips
Songbird”

“Philips Songbird

“Philips Songbird”

1. “Philips Songbird”
“Tools” > “Options”…

2. “Media Importer” “iTunes
Importer”

3.

4. “Import Library”

“Philips Songbird”

“Philips Songbird”

1. “Tools” > “Options”

2. “Options” iz “Media Importer”
“Watch Folders”

3. “Watch Folders”

4. “Browse”

“Philips Songbird”

�

�

�

�

�

... Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”



30

Mediju failu importçðana Meklçðana tieðsaistç

Atskaòojamo sarakstu veidoðana

Datu iegûðana no tieðsaistes
avotiem

Atskaòojamo sarakstu veidoðana
programmâ “Philips Songbird”

Piezîme

�

�

Pirms satura lejupielâdçðanas vai
iegâdâðanâs no tieðsaistes pakalpojumu
sniedzçjiem abonçjiet tieðsaistes
pakalpojumu un reìistrçjieties savâ kontâ.

Daþi pakalpojumi ir pieejami tikai noteiktâs
valstîs.

Mediju failu importçðana no citâm mapçm

“Philips Songbird”

“File” > “Import Media”

“Library”

“File” > “Import a playlist”

“Playlists”

1.

“Services”

2.

Programmâ

Uzejiet uz , lai
izvçlçtos mapes datorâ.

Mediju faili tiek pievienoti mapei

vai uzejiet uz ,
lai datorâ izvçlçtos atskaòojamos sarakstus.

Mediju faili tiek pievienoti mapei
.

Jûs varat piekïût datiem un iegâdâties tos no
tieðsaistes avotiem. Atrodiet pieejamos tieðsaistes
pakalpojumus avota izvçles logâ opcijâ “Services”.

Izvçlieties tieðsaistes pakalpojumu:

Izvçlieties opciju ;

Alternatîva: meklçðanas logâ uzklikðíiniet uz
lejupvçrstâs bultiòas, lai izvçlçtos tieðsaistes
pakalpojumu.

Jûs ieejat tieðsaistes avota mâjaslapâ.

Meklçjiet savu mediju failu.

Ja nepiecieðams, lietojiet meklçðanas lauku,
lai ievadîtu atslçgas vârdu.

Lietojot atskaòojamo sarakstu, jûs varat organizçt
un sinhronizçt savas dziesmas tâ, kâ jums
nepiecieðams.

Izvçlieties dziesmas, ko vçlaties atskaòot.
Pievienojiet dziesmas atskaòojamajam sarakstam.

�

�

�

�

�

�

�

�

... Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”



31

1. “Library” > “Music”

“Ctrl”

2.

“Add to
Playlist”

“New Playlist”

“Playlists”

1. “Playlists”

2.

3.

“LikeMusic”

“LikeMusic”

“LikeMusic”

“Philips Songbird”
“LikeMusic”

“LikeMusic”

Izvçlnç izvçlieties dziesmas.

Lai izvçlçtos vairâkas dziesmas, klikðíinot uz
dziesmâm, piespiediet un paturiet nospiestu

taustiòu.

Lai pievienotu dziesmas atskaòojamajam
sarakstam:

Uzklikðíiniet uz dziesmâm ar peles labo
taustiòu un izvçlieties opciju

(Pievienot atskaòojamajam
sarakstam).

Izvçlieties atskaòojamo sarakstu.
Dziesmas tiek pievienotas
atskaòojamajam sarakstam.

Lai izveidotu atskaòojamo sarakstu,
izvçlieties (Jauns
atskaòojamais saraksts).

Jauns atskaòojamais saraksts dziesmâm
ir izveidots.
Izvçlnç nosauciet atskaòoja-
mo sarakstu tâ, kâ jums nepiecieðams.

Alternatîva:

Izveidojiet atskaòojamo sarakstu. Pievienojiet
atskaòojamajam sarakstam izvçlçtâs dziesmas.

Izvçlnç uzklikðíiniet uz +, lai
izveidotu atskaòojamo sarakstu.

Jauns atskaòojamais saraksts ir izveidots.

Nosauciet jauno atskaòojamo sarakstu, kâ
vçlaties.

Ar “pârneðanas” metodi (“Drag and drop”)
pârnesiet mediju failus uz atskaòojamo
sarakstu.

Pamatojoties uz veikto analîzi,
atskaòojamo sarakstu var veidot no “dîgïa”
dziesmas.

analizç dziesmas jûsu bibliotçkâ un,
pamatojoties uz noteiktâm mûzikas pazîmçm,
konstatç sakarîbas starp tâm. izveido
atskaòojamos sarakstus, kuros iekïautâs dziesmas
lieliski saskan un izklausâs kopâ.

Kad importçjat dziesmas savas mûzikas
programmas bibliotçkâ,

sâk to analîzi. Pie dziesmas, kura
izanalizçta, iedegas ikona. Pie
dziesmâm, kuras netiek izanalizçtas, ikona paliek
nemainîgi pelçka.

�

�

�

�

�

�

�

�

Padoms

� Lai “pârnestu” vairâkus failus vienlaicîgi,
klikðíinot uz izvçlçtajiem failiem,
piespiediet un paturiet nospiestu taustiòu

.“Ctrl”

“LikeMusic” (Lîdzîgâs mûzikas)
atskaòojamo sarakstu veidoðana

... Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”
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“Dîgïa” dziesmas izvçle

Izvçlieties maksimâlo dziesmu skaitu sarakstâ

Saglabâjiet “LikeMusic” atskaòojamo sarakstu

Atskaòojamâs rindas izveidoðana

Pârliecinieties, ka 'dîgïa' dziesmas
analîze ir pabeigta.

Izvçlnç uzklikðíiniet
dubultklikðíi uz dziesmas zilâs
ikonas.

Alternatîva:

Izvçlnç ar peles labo
taustiòu uzklikðíiniet uz dziesmas un
izvçlieties opciju .

atskaòojamais saraksts tiek
parâdîts lapâ.

Izvçlieties numuru sarakstâ.

Uzklikðíiniet uz opcijas
“LikeMusic” lapâ.

atskaòojamais saraksts ir
saglabâts sadaïâ
(Atskaòojamie saraksti).

“Pârnesiet” (“Drag and drop”) dziesmas vai
atskaòojamos sarakstus uz
logu.

“LikeMusic”

Library > Music
“LikeMusic”

“Library” > “Music”

“Run LikeMusic with”
“LikeMusic”

“LikeMusic”

“Save as playlist”

“LikeMusic”
“Playlists”

“Play Queue”

�

�

�

�

�

�

�

Atskaòojamâs rindas kâ atskaòojamâ
saraksta saglabâðana

... Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”
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Atskaòojamâs rindas kâ atskaòojamâ saraksta
saglabâðana

1. “Save”

“Playlists”

2. “Playlists”

Dziesmu pievienoðana atskaòojamâs rindas
sâkumâ vai beigâs

“Queue Next”

“Queue Last”

1.

“Play”

2.

1. “Library” > “Music”

2.
“View Metadata”

“Philips Songbird”

Uzklikðíiniet uz .
Atskaòojamâ rinda ir saglabâta kâ
atskaòojamais saraksts sadaïâ
(Atskaòojamie saraksti).

Sadaïâ nosauciet atskaòojamo
sarakstu, kâ jums nepiecieðams.

Lai pievienotu dziesmas atskaòojamâs rindas
sâkumâ, ar peles labo taustiòu uzklikðíiniet
uz opcijâm un izvçlieties ;

Lai pievienotu dziesmas atskaòojamâs rindas
beigâs, ar peles labo taustiòu uzklikðíiniet uz
opcijâm un izvçlieties .

Lai atskaòotu visu atskaòojamo sarakstu,
uzklikðíiniet ar peles labo taustiòu uz
atskaòojamâ saraksta un izvçlieties
(Atskaòot).

Lai sâktu atskaòoðanu no dziesmas,
uzklikðíiniet dubultklikðíi uz attiecîgâs
dziesmas.

Lai izvçlçtos atskaòoðanas opcijas, uzklikðíiniet
uz taustiòiem atskaòotâja logâ.

Rediìçjot failu informâciju (metadatus vai ID3
tagus), jûs varat automâtiski kârtot failus pçc
dziesmu nosaukumiem, izpildîtâja, albuma un citas
informâcijas.

Pçc mediju failu sinhronizçðanas atskaòotâjâ jûs
mediju bibliotçku varat pârskatît pçc metadatiem.

Izvçlnç izvçlieties mediju
failu.

Ar peles labo taustiòu uzklikðíiniet uz faila, lai
izvçlçtos opciju .

Metadatu tabula parâdâs, lai jûs varçtu
rediìçt informâciju.

Albuma noformçjums daþreiz ir pieejams mûzikas
lejupielâdçm. Ar programmu
jûs varat dziesmâm ievietot noformçjumu.

Pçc dziesmu sinhronizçðanas ar daþiem
atskaòotâjiem, Jûs mediju bibliotçku varat pârskatît
pçc noformçjuma.

�

�

�

�

�

Atskaòojamâ saraksta atskaòoðana

Metadatu rediìçðana

Albuma noformçjuma iegûðana

Mediju failu organizçðana
programmâ “Philips Songbird”

... Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”
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�

�

Programmâ , izvçlieties
.

Noformçjums tiek pieðíirts visiem
virsrakstiem bibliotçkâ.

Ar peles labo taustiòu uzklikðíiniet uz
izvçlçtajiem virsrakstiem un izvçlieties

.
Noformçjums tiek pieðíirts visiem
izvçlçtajiem virsrakstiem.

Ar peles labo taustiòu uzklikðíiniet uz mediju
faila. Izvçlieties opciju .

Apstipriniet savu izvçli.
Izvçlçtais fails ir izslçgts no bibliotçkas un
no visiem atskaòojamajiem sarakstiem
(Pçc noklusçjuma fails ir tikai “izslçgts“,
bet ne “dzçsts“. Fails joprojâm ir saglabâts
tâ oriìinâlajâ atraðanâs vietâ datorâ vai
datoru sakaru tîklâ.)

Datorâ startçjiet programmu
.

Pieslçdziet atskaòotâju pie datora, lietojot USB
vadu.

Programmâ
atskaòotâjs parâdâs, kad dators to atpazîst.

Pirmo reizi pieslçdzot atskaòotâju programmai
, izvçlieties automâtisko

sinhronizçðanu, kâ tas tiek prasîts. Atskaòotâjs
automâtiski tiek sinhronizçts ar programmu

.

Ja jûs neizvçlaties automâtisko sinhronizçðanu, jûs
pârslçdzaties uz manuâlo sinhronizçðanu.

“Philips Songbird“
Tools > Get Artwork

Get
Artwork

1.
“Remove”

2.

1. “Philips
Songbird”

2.

“Philips Songbird”

“Philips Songbird”

“Philips Songbird”

�

�

�

�

Mediju failu dzçðana no bibliotçkas

Automâtiskâs vai manuâlâs
sinhronizçðanas izvçlePadoms

�

�

Lai izvçlçtos vairâkus failus, uzklikðíinot uz
tiem, piespiediet un paturiet nospiestu
taustiòu .

Lai izvçlçtos vairâkus secîgus failus,
uzklikðíinot uz pirmâ un pçdçjâ izvçlçtâ
faila, piespiediet un paturiet nospiestu
taustiòu .

Ctrl

Shift

Atskaòotâja sinhronizçðana ar
programmu “Philips Songbird”

... Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”
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Lai izvçlçtos automâtisko vai manuâlo
sinhronizçðanu:

1. “Devices

2. “Manual”
“Auto”

3. “Apply”

“Devices” “Sync”

Lai izvçlçtos automâtiskâs sinhronizçðanas
iestatîjumus:

1. “Devices

2. “Music”

3.

Lai manuâli pârraidîtu izvçlçtos atskaòojamos
sarakstus:

1.

2.
VIBE

Lai manuâli pârraidîtu izvçlçtos mediju failus:

1.

2. Add to Device > VIBE
VIBE

Izvçlieties atskaòotâju sadaïâ ”.
Parâdâs ekrâns.

Ekrânâ izvçlieties (manuâlâ
sinhronizçðana) vai (Automâtiskâ
sinhronizçðana).

Lai apstiprinâtu opciju, uzklikðíiniet uz
(Apstiprinât).

Ja esat izvçlçjuðies automâtisko
sinhronizçðanu, tâ sâkas uzreiz, tiklîdz jûs
pieslçdzat atskaòotâju pie datora;

Alternatîva: izvçlieties atskaòotâju sadaïâ
un uzklikðíiniet uz .

Izvçlieties atskaòotâju sadaïâ ”.

Ekrânâ uzklikðíiniet uz (Mûzikas)
cilnes.

Uzklikðíiniet, lai izvçlçtos opciju.

Izvçlieties atskaòojamos sarakstus.

“Pârnesiet” (“Drag and drop”) atskaòojamos
sarakstus uz atskaòotâju.

Satura logâ ar peles labo taustiòu uzklikðíiniet
uz izvçlçtâ mediju faila;

Izvçlieties opciju .
Izvçlçtie faili tiek pârraidîti uz
atskaòotâju.

�

��

�

Automâtiskâ sinhronizçðana

Manuâlâ sinhronizçðana

Padoms

� Lai izvçlçtos vairâkus failus vienlaicîgi,
klikðíinot uz izvçlçtajiem failiem,
piespiediet un paturiet nospiestu taustiòu

.“Ctrl”

... Sinhronizçðana ar datora mûzikas bibliotçku,
lietojot programmu “Philips Songbird”
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VIBE

VIBE

“Philips Songbird”

VIBE

1.

2. VIBE

3. “Philips Songbird”

“Start”>
“Programs” >”Philips” > “Philips
Songbird

4. VIB
“Tools” >
“Check for updated firmware”

“Philips Songbird”

5.

VIBE

atskaòotâju pârvalda iekðçjâ programma –
programmaparatûra. Jauna tâs versija var tikt izdota
pçc tam, kad esat iegâdâjuðies atskaòotâju.

Lietojot programmu jûs varat
pârbaudît un instalçt pieejamos programmatûras
atjauninâjumus atskaòotâjam, kas pieejami
internetâ.

Pârliecinieties, ka dators ir pievienots pie
interneta.

Pieslçdziet atskaòotâju pie sava datora,
lietojot USB vadu.

Datorâ startçjiet .

Ja nepiecieðams, uzklikðíiniet uz

”.

Atskaòotâja logâ uzklikðíiniet uz E, tad
izvçlieties uznirstoðajâ logâ
izvçlieties .

programma pârbauda
atjauninâjumus un instalç jaunu
programmatûru no interneta, ja pieejama.

Sekojiet lîdzi ekrânâ redzamajâm instrukcijâm
un izpildiet tâs.

Programmatûras atjauninâjuma
lejupielâdçðana un uzstâdîðana sâkas
automâtiski.

atskaòotâjs izslçdzas un ieslçdzas
pçc programmatûras atjauninâðanas un
atkal ir gatavs lietoðanai.

�

�

�

�

Padoms

Piezîme

�

�

Atjauninot programmatûru, jûsu mûzikas
faili netiks bojâti.

Pagaidiet, lîdz atjauninâðana ir pabeigta,
tad atvienojiet atskaòotâju no datora.VIBE

13. Programmatûras atjauninâðana, lietojot
programmu “Philips Songbird”
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Ja atskaòotâjs darbîbâ ir traucçjumi un ekrâns
sastingst, jûs varat to atiestatît, nezaudçjot datus.

Ievietojiet lodîðu pildspalvas galu vai citu
smailu priekðmetu atiestatîðanas atverç uz
atskaòotâja pamatnes. Paturiet to, lîdz
atskaòotâjs izslçdzas.

Datorâ startçjiet programmu
”.

programmâ:

Izvçlieties
(Labot manu Philips ierîci).

Uznirstoðajâ sarakstâ izvçlieties .

Pievienojiet atskaòotâju pie datora.

Izpildiet ekrânâ redzamâs instrukcijas, lai
pabeigtu laboðanu.

VIBE

Lai atiestatîtu VIBE atskaòotâju:

VIBE

Ja jums neizdodas atiestatît atskaòotâju, labojiet
to, lietojot programmu “Philips Songbird”:

1. “Philips
Songbird

2. “Philips Songbird”

“Tools” > “Repair my Philips
Device”

VIBE

3.

Sekojiet lîdzi ekrânâ redzamajâm
instrukcijâm, kâ pievienot atskaòotâju
datoram, un izpildiet tâs.

4.

�

�

�

�

Padoms

� Pçc atskaòotâja laboðanas CD-ROM
nodalîjums un
instalçtâjfails ir izdzçsts no atskaòotâja .
Atskaòotâjâ ir pieejams vairâk vietas.

“Philips Songbird”

14. Atskaòotâja laboðana, lietojot programmu
“Philips Songbird”
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15. Tehniskie dati

Elektriskâ padeve

Programmatûra

Savienojamîba

Skaòa

Audio atskaòoðana

Video atskaòoðana

Attçlu parâdîðana

Saglabâðanas medijs

Mediju pârraide

Ekrâns

3

Piezîme

�

�

�

1

2

3

Pârlâdçjamâm baterijâm ir ierobeþots
lâdçðanas ciklu skaits, un tâs galu galâ var
bût jânomaina. Baterijas kalpoðanas laiks
un pârlâdçðanas ciklu skaits mainâs
atkarîbâ no lietoðanas un iestatîjumiem.

1GB = 1 biljons baitu; pieejamâ
saglabâðanas ietilpîba bûs mazâka. Pilna
atmiòas ietilpîba var nebût pieejama, jo
daïa atmiòas tiek rezervçta atskaòotâjam.
Saglabâðanas ietilpîba balstîta uz aprçíinu:
4 minûtes vienai dziesmai un 128 kbps
MP3 kodçðana.

Pârraides âtrums ir atkarîgs no
operçtâjsistçmas un programmatûras
konfigurâcijas.

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Elektriskâ padeve: iekðçjâ pârlâdçjamâ Li-ion
polimçru iebûvçtâ baterija 290 mAh

Atskaòoðanas laiks
Mûzika (.mp3) atskaòoðanas laiks: lîdz 20
stundâm (iezîme izslçgta)
lîdz 12 stundâm (iezîme ieslçgta)
Video (.mp4): lîdz 4 stundâm
Radio atskaòoðanas laiks: lîdz 10 stundâm

“Philips Songbird”: programmatûras
atjauninâðanai un mûzikas pârraidei .

“Philips Media Converter: video pârveidoðanai
un pârraidîðanai

Austiòas 3.5 mm

USB 2.0 liels âtrums

Kanâlu noðíirtîba: > 45 dB

Frekvenèu veiktspçja: 80-18000 Hz

Izejas jauda: 2 x 2.4 mW

Signâla-trokðòa attiecîba: >84 dB

Atbalstîtie formâti:

MP3:
Bitu âtrums: 8-320 kbps un VBR
Iztverðanas âtrums: 8, 11.025, 16, 22.050, 32,
44.1, 48 kHz

WMA
Bitu âtrums: 10-320 kpbs CBR, 32-192 kbps
VBR
Iztverðanas âtrums: 8, 11.025, 16, 22.050, 32,
44.1, 48 kHz

FLAC
Bitu âtrums: Lîdz 1.1 Mbps
Iztverðanas âtrums: 48kHz

APE
Bitu âtrums: Lîdz 1.3Mbps
Iztverðanas âtrums: 48 Khz

Atbalstîtie formâti:

SMV

Atbalstîtie formâti:

JPEG

BMP

Iebûvçtâs atmiòas ietilpîba

SA4VBE04 4GB NAND Flash

SA4VBE 08 8GB NAND Flash

SA4VBE 16 16GB NAND Flash

“Songbird” (mûzikas sinhronizçðana)

Media Converter (video pârraide)

“Windows Explorer” (“pârnest”) (“Drag and
drop”)

Krâsains LCD 128 x 160 pikseïi

1

3

3

2

'FullSound'
'FullSound'
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... Tehniskie dati

Specifikâcijas var tikt mainîtas bez brîdinâjuma.

© 2012 Koninklijke Philips Electronics N.V.

Visas tiesîbas ir aizsargâtas.

Datorsistçmas prasîbas
�

�

�

�

�

�

�

�

Windows® XP (SP3 vai jaunâks), Vista/7

Pentium III 800MHz procesors vai labâks

512 MB RAM

500MB vieta cietajâ diskâ

Interneta savienojums

Windows® Internet Explorer 6.0 vai jaunâks

CD-ROM diskdzinis

USB ports



Apmeklçjiet Philips Internetâ
http://www.philips.com


